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Mobile Picture & Video Player with Camera
 (Version 1.0 US)

User's Guide

Important

•The contents of this User's Guide are subject to change without notice.

•This software is intended for viewing still images and movie format files and for

listening to audio and music files only for your own personal enjoyment. Such files

are normally protected by copyright law and by international treaties. You may not

otherwise reproduce, distribute, publicly perform, publicly display, or create deriva-

tive works of such files, unless authorized by the appropriate copyright owner(s).

•The explanations in this manual all assume that you are familiar with the button and

screen operations, and all other basic operational procedures of your CASSIOPEIA.

If you are not, see the CASSIOPEIA's User's Guide.

•The screen shots that appear in this manual may differ from the appearance of the

screens that appear when you actually operate your CASSIOPEIA.

Trademarks
Microsoft, Windows, and Windows NT are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.
All other product and company names mentioned herein may be the trademarks of their respective
owners.

Copyright Notice
No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or
translated into any human or computer language, in any form or by any means,  without the express
written permission of CASIO COMPUTER CO., LTD.

Copyright 2000 CASIO COMPUTER CO., LTD. All rights reserved.
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Introduction
Mobile Picture & Video Player with Camera  is a program that lets you record and
playback snapshots and movies with a digital camera card installed in the card slot of
your CASSIOPEIA. It also includes a thumbnail viewer and other functions for easy
management of your movies and snapshots.

 Features and Functions

Image recording (Page 6)
Record snapshots, stop action images, and movies. Snapshots are stored as
JPEG files, while movies are stored using CASIO's original CMF file format.

Thumbnail viewer and data management (Page 17)
A thumbnail index shows thumbnails of snapshots and movies. You can use the
thumbnail index to edit file names, to move files between folders and storage
locations, to view properties, and perform other file operations. You can also
display individual snapshots, play movies, and start a slideshow from the thumb-
nail index.

Album generator (Page 49)
Generate an instant album of all the snapshots and movies contained in a particu-
lar folder. Then you can insert comments, add or delete pages, and paste and
remove images, just as you would with a real photo album. Easy operations let
you delete an album or move it to another memory location (main memory or
storage card).

Supported File Formats

Mobile Picture & Video Player with Camera supports record and playback of the
following file formats.

Snapshot files.. .JPEG files
Movie files .......CASIO's original CMF file format

The term “snapshot” as used in this manual refers to JPEG and JPG files, while
“movie” refers to CMF files.
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To start up Mobile Picture & Video Player with Camera

1. Install the Digital Camera Card into the card slot of your CASSIOPEIA.

•See the separate documentation that comes with the Digital Camera Card
for details about installation.

2. Turn on your CASSIOPEIA.

3. Tap , Programs, and then Picture & Video Player.
The movie camera screen appears the first time you start up Mobile Picture &
Video Player with Camera.

Movie camera screen

•The screen you were using last (camera screen, image display screen, album
index screen) appears the next time you start it up.

•The movie index appears if you start up Mobile Picture & Video Player with

Camera. while the Digital Camera Card is not installed on the CASSIOPEIA.



- 6 - Mobile Picture & Video Player with Camera

Recording

Mobile Picture & Video Player with Camera lets you record both snapshots and mov-
ies. You can also record a series of stop action snapshots over a specific period.

Getting Ready

Check the following points before trying to record.

•Make sure the Digital Camera Card is correctly installed into the card slot of

your CASSIOPEIA. See the separate documentation that comes with the Digital
Camera Card for details about installation.

•See the separate documentation that comes with the Digital Camera Card for
information about adjusting the focus range, rotating the lens, and other Digital
Camera Card operations.

•Check the remaining power levels of the main battery and back up battery of

your CASSIOPEIA. If they are low, replace or recharge them.

Precautions

Note the following important precautions whenever recording.

•Never tap the display screen of your CASSIOPEIA, turn its power off, or press

any of its buttons to start up another application under any of the following
conditions.
•  When recording is in progress, which is indicated by the display message

"Recording".
•  When an image data store operation is in progress, which is indicated by the

display message "Movie store" or “Snapshot store”.
•  Note, however, that you can cancel an ongoing image data store operation

by tapping the Cancel button on the data save dialog box.

•The number of seconds allowed for movie recording depends on the amount of
free memory space available. If you need to increase recording time, increase
the Program memory on the Memory dialog box ( - Settings - System tab -
Memory). If there is still not enough, you can delete applications you no longer
need or transfer data to a storage card to increase data storage memory and
then allocate more memory to program execution.
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Selecting a Camera

Use the following procedures to select either   for recording snapshots or
  for recording movies.

To select a camera

1. On the command bar, tap   to display the camera screen.

2. Tap one of the camera buttons in the upper left corner of the screen to select
the one you want.

•   is for recording snapshots and   is for recording movies.

Snapshot camera screen Movie camera screen

•You can also toggle between cameras by pressing the CASSIOPEIA's
ACTION control.
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Recording Snapshots

Use  (page 7) for recording snapshots.

To record snapshots

1. Start up Mobile Picture & Video Player with Camera.

2. Display the snapshot camera screen.

•Check to make sure that the message Ready to record is in the status bar.

See "Interpreting Status Bar Information" on page 13 for details.

3. Enter the Snapshot Mode.

•Steps 4 through 8 cover other pre-shutter release settings that are not es-

sential and may be skipped if you want.

4. Specify the image quality.

•On the control panel, tap the image quality button to cycle through the image
quality settings shown below.

 ... Fine (highest quality, largest file size)

 ... Normal (medium quality, medium file size)

 ... Economy (lowest quality, smallest file size)

Folder box

Icon bar

Status bar

Viewfinder

Control panel
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5. Specify the image size.

•On the control panel, tap the image size button to cycle through the image

size settings shown below.

 ... VGA (640 x 480)

  ... 1/4 VGA (320 x 240)

  ... 1/9 VGA (212 x 160) : This setting can be used for stop action only.

  ... 1/16 VGA (160 x 120) : This setting can be used for stop action only.

6. Make white balance and other settings as required.

•Tap the  button. This causes icons showing the current record settings

to appear in the icon bar.

•See "Making Record Settings" on page 14 for details about the meaning of

each icon and how to make these settings.

7. Specify the storage location of the image, if you want.

•Tap the folder box to display the Add/Delete Folders screen, and then tap

the folder where you want the image to be stored. The default storage loca-
tion is a folder named "Record".

•You can also use the  Add/Delete Folders screen to create a new folder.

See "Using Folders" on page 19 for details.

8. Rotate the focus adjustment dial of the lens to focus the subject.

9. Record the image.

•Compose the image on the CASSIOPEIA screen and then tap the 

button to record the image and store it as a JPEG file.

•To record more images, simply tap the  again.

•To view images you just recorded, tap  to change to the thumbnail index.

See "Playing Back Images" on page 17 for more information.

///// Note /////
File names are assigned automatically to images as you record them. See "File
Names" on page 13 for more information.
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Stop Action Images

Stop action recording lets you record a series of images that effectively break
action into a series of segments. The number of images recorded when you press

the   button depends on the image size, as shown in the table below.

Image Size Number of Images

VGA (640 x 480) 2

1/4 VGA (320 x 240) 8

1/9 VGA (212 x 160) 12

1/16 VGA (160 x 120) 32

The image recording procedure is identical to that under "Recording Snapshots"

on page 8, except that in step 3 you press the  button and enter the Stop

Action Mode instead of the  button.

///// Note /////

•In the Stop Action Mode, recording continues and the image on the display

remains unchanged until all the images are recorded.

•After image recording is complete, a dialog appears telling you that the images

are being stored in memory.

•You can specify how many images are recorded per second. See "Making
Record Settings" on page 14 for details.

Using Timer Recording

You can set a timer for snapshot and stop action recording so the record operation

starts after 10 seconds have passed. To use the timer, tap the  button on the

control panel. This enables the timer, which is indicated by the timer button chang-

ing to .

•The timer time counts down on the display.

•You can interrupt the timer countdown by tapping the  button or chang-

ing to another screen.

•To cancel timer operation, tap the  button so it changes to .
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Recording a Movie

Use   (page 7) for recording movies.

To record movies

1. Start up Mobile Picture & Video Player with Camera.

2. Display the movie camera screen.

•Check to make sure that the message "Ready to record" is in the status bar.

See "Interpreting Status Bar Information" on page 13 for details.

•Steps 3 through 7 cover other settings that are not essential and may be
skipped if you want.

3. Specify the image size.

•On the control panel, tap  to select 1/9 VGA size or   to select 1/16

VGA size. A pink bar appears over the button whose size is currently se-

lected.

4. Specify whether or not you want to record audio along with the movie.

•On the control panel, tap the  button to toggle audio recording on 

and off  .

Icon bar

Status bar

Control panel

Viewfinder

Folder box
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5. Make white balance and other settings as required.

•On the control panel, tap the  button. This causes icons showing the

current record settings to appear in the icon bar.

•See "Making Record Settings" on page 14 for details about the meaning of

each icon and how to make these settings.

6. Specify the storage location of the image, if you want.

•Tap the folder box to display the Add/Delete Folders screen, and then tap

the folder where you want the image to be stored. The default storage loca-
tion is a folder named "Record".

•You can also use the  Add/Delete Folders screen to create a new folder.
See "Using Folders" on page 19 for details.

7. Rotate the focus adjustment dial of the lens to focus the subject.

8. Record the image.

•Tap the  button and record while monitoring the scene on the

CASSIOPEIA display.

9. To stop recording, tap the  button.

•This stops recording and starts processing the data to compress and store it.

A dialog appears on the screen to let you know that the data is being stored.

•The Thumbnail Index screen re-appears after the data save operation is

complete.

•See "Playing Back Images" on page 17 for information about how to view a

movie you recorded.

///// Note /////
File names are assigned automatically to movies as you record them. See "File
Names" on page 13 for more information.
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Interpreting Status Bar Information

The status bar shows the status of Mobile Picture & Video Player with Camera,
and the number of snapshots you can store or how many minutes of movie re-
cording you can perform under current settings.

action image

File Names

File names are assigned to image files using the following formats.

Snapshots
Example: PIC06230001.jpg

          Indicates snapshot  Month  Day  Number  Extension

Stop Action Images
Example: CON06230001.jpg - CON06230008.jpg

         Indicates stop    Month    Day   Number    Extension

Movies
Example: MOV06230001.jpg

  Indicates movie  Month  Day  Number  Extension

"Ready to record"
Press the SHUTTER button to record.

"Recoding"
Image or movie record operation is in
progress.

"Saving the recording image"
Recorded images are being stored in
memory.

“Setup failed”
Image or movie recording cannot be
performed because the Digital Camera
Card is not installed in the CASSIO-
PEIA correctly, etc.

Shows the number of snapshots
you can store or how many sec-
onds of movie recording you can
perform under current settings.

Snapshots: 000 shots

Movie: xx/yyy sec
xx ..... Maximum length of each

movie* (in seconds)
yyy ... Total length of movies

* The length of each movie that you can
record depends on the amount of pro-
gram memory available.
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Making Record Settings

On the Movie camera screen or snapshot camera screen, tap the icon bar area
(page 11) to display the Record Settings dialog box. The format of the Record
Settings dialog box depends on whether you started from the movie camera
screen or snapshot camera screen.

///// Note /////
The icons shown in parentheses in the following explanation are the icons that
appear in the icon bar. See "Recording Snapshots" on page 8 and "Recording a
Movie" on page 11 for more information about the icon bar.

 Snapshot Record Settings

Continuous record interval
Short ...................15 images per second
Normal ................10 images per second
Long ....................5 images per second

White Balance

Outdoor daylight ( ) ............ For recording under sunlight

Incandescent lighting ( ) .... For recording under illumination from light bulbs

Fluorescent lighting ( ) ....... For recording under illumination from fluores-

cent light

Auto ( ) ............................... Automatic white balance

Record Mode

Normal recording ( ) .......... For portraits, scenery, etc.

Business card recording ( ) For business cards, documents, and other

items with large white areas. Selecting this

operation disables the White Balance setting.
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Movie Record Settings

Approximate Record Time
This value shows the maximum number of seconds you can record, based on
free space available in main memory.

Approximate Save Time
This value shows how many seconds it will take to store recorded data if all of
the recording time is used.

White Balance

Outdoor daylight ( ) ............ For recording under sunlight

Incandescent lighting ( ) .... For recording under illumination from light bulbs

Fluorescent lighting ( ) ....... For recording under illumination from fluores-

cent light

Auto ( ) ............................... Automatic white balance
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Adjusting Camera Screen Brightness

Use the following procedure to make separate camera screen settings during
battery-powered operation and external AC power operation.

To adjust the camera screen brightness

1. On the View menu, tap Brightness.

2. Drag the sliders left or right to adjust screen brightness during battery powered
operation and external AC power operation.

•The brightness of the screen changes immediately when you change the

position of the slider for the power source you are currently using.

3. After making the settings you want, tap OK to apply them.
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Playing Back Images from a Camera Screen

From a camera screen screen, tap  .

• If you tap  on the snapshot camera screen, the snapshot index appears

first.

• Tapping  on the movie camera screen causes the movie index to appear

first.

Thumbnail Index

The thumbnail index shows six thumbnails of snapshots or movies.

 Playing Back Images

Mobile Picture & Video Player with Camera provides you with a number of different
ways to view JPEG and CMF format files.

To view: Use the:

All snapshots in a folder Snapshot index
All movies in a folder Movie index
A specific snapshot Snapshot screen
A series of snapshots Slideshow screen
A specific movie Movie screen

A blue frame indicates
the currently selected
image. Its file name is
also highlighted. Use the
cursor keys or
ACTION control to
select another image.

Thumbnail
Shows the snapshot or
movie.

Folder box
The thumbnail index
shows all the snap-
shots or movies in the
currently selected
folder.

File name
 indicates main

memory file, 
indicates storage
card file.
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You can perform the following operations from the thumbnail index.

•Switch between the snapshot index and movie index

•Select a folder

•Display the snapshot screen (from the snapshot index)

•Display the slideshow screen (from the snapshot index)

•Display the movie screen (from the movie index)

•Delete files

•View file properties and edit file data (file name, folder, storage location) on

Rename/Move screen

•Automatically generate thumbnails on the thumbnail index

•Move or delete all the files in a folder

•Generate albums

•Playback snapshots or movie files attached to e-mail

Each of these operations is described in detail in the following sections of this
manual.

Switching Between the Snapshot and Movie Index

•To switch to the movie index from the snapshot index, tap the View  menu and

then  Movie Screen.

•To switch to the snapshot index from the movie index, tap the View  menu and

then  Snapshot Screen.

///// Note /////
You cannot display snapshots and movies in the same thumbnail index.
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Selecting the Thumbnail Index Folder

The thumbnail index shows all of the snapshots or movies in the currently se-
lected folder. To change to another folder, follow the steps below.

1. Tap the folder box.

•This displays the Add/Delete Folders screen.

2. Tap the folder you want to select.

3. Tap OK to display the contents of the folder on the Thumbnail Index screen.

///// Note /////

•The thumbnail index automatically generates thumbnail files for the images it

displays.

Using Folders

You can create a new folder, rename or delete a folder using the following proce-
dures. You can perform this procedure while the Thumbnail Index screen or Cam-
era screen is on the display.

 To create a new folder

1. Tap the folder box.

•This displays the Add/Delete Folders screen.

2. On the Add/Delete Folders screen, tap the folder inside of which you want to
create the new folder.
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3. Tap the New button.

4. Input the name you want to assign to the folder and then tap OK.

•This creates the new folder and makes it the currently selected folder.

5. Tap OK to return to the Thumbnail Index screen (or Camera screen).

To rename a folder

1. Tap the folder box to displays the Add/Delete Folders screen.

2. On the Add/Delete Folders screen, tap the folder whose name you want to
change.

3. Tap the Rename button to display the Rename Folder screen.

4. Type the new name and then tap OK.

•This changes the folder name and returns to the Add/Delete Folders

screen.

To delete a folder

1. Tap the folder box to displays the Add/Delete Folders screen.

2. On the Add/Delete Folders screen, tap the folder you want to delete.

3. Tap the Delete button.

4. In response to the confirmation message that appears, tap Yes to delete the
folder or No to cancel without deleting anything.

•You will not be able to delete a folder if it contains files. Use File Explorer to

check the contents of a folder. See the Pocket PC User’s Guide or CASSIO-
PEIA online help for information about how to use File Explorer.
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Displaying a Specific Snapshot

You can select one of the thumbnails in the snapshot index and then display a
large-size image in the snapshot screen.

                    Snapshot Index                                      Snapshot Screen

You can display the large-size image of a thumbnail using any of the following
methods.

•Tap the thumbnail of the image you want to display.

•Select the thumbnail of the image you want to display so its file name is high-

lighted, and then press the CASSIOPEIA's ACTION control.

To return to the snapshot index from the snapshot screen, tap the  button.

///// Note /////
You can also use the snapshot screen to change the view of the image, to change
to another image, and perform other operations. See "Using the Snapshot
Screen" on page 37 for more information.
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Displaying the Slideshow Screen

The slideshow screen lets you automatically scroll through images one-by-one.
Note that you can display the slide show screen only from the snapshot index.

                Snapshot Index                                 Slideshow Screen

To display the slideshow screen, tap the snapshot index View  menu and then tap
Slideshow .

•The image that is selected on the snapshot index is the one that appears first on

the slideshow screen.

•To start the slideshow, tap the  button. Snapshots appear in the same

sequence that they appear on the snapshot index.

•To stop the slideshow, tap the  button.

•To return to the snapshot index from the slideshow screen, tap the  button.

///// Note /////
See "Using the Slideshow Screen" on page 40 for more information about
slideshow screen operations.



- 23 - Mobile Picture & Video Player with Camera

Displaying the Movie Screen

You can select one of the thumbnails in the movie index and then display its
movie screen.

                    Movie Index                                        Movie Screen

You can display the movie screen using any of the following methods.

•Tap the thumbnail of the movie.

•Select the thumbnail of the movie so its file name is highlighted, and then press

the CASSIOPEIA's ACTION control.

To return to the movie index from the snapshot screen, tap the  button.

///// Note /////
You can also use the movie screen to playback the movie and perform other
operations. See "Using the Movie Screen" on page 42 for more information.
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Deleting Files

Use the following procedure to delete files on a thumbnail index screen.

To delete files

1. On a thumbnail index screen, tap and hold the thumbnail for the file you want to
delete,  and then tap Delete on the shortcut menu that appears.

2. On the confirmation dialog box that appears, tap YES to delete the file.

•You can also delete folders. See "Deleting All the Files in a Folder" on page

27 for details.

Renaming and Moving a File

Use the Rename/Move screen to change the name of the currently selected file
or to move the file to a different storage location.

 

Rename/Move screen

To rename a file

1. On a thumbnail index, tap and hold the thumbnail of the file you want to re-
name,  and then tap Rename/Move on the shortcut menu that appears.

2. In the Name box, input the new name you want to assign to the file.

3. Tap OK to store the file under its new name.



- 25 - Mobile Picture & Video Player with Camera

To move a file

1. On a thumbnail index, tap and hold the thumbnail of the file you want to move,
and then tap Rename/Move on the shortcut menu that appears.

•This displays the Rename/Move screen.

2. Tap the Folder box to displays the Select Folder screen.

3. On the Select Folder screen, tap the folder to which you want to move the file.

4. Tap OK to go back to the  Rename/Move screen.

5. Tap OK to move the file.

///// Note /////

•You can also use the Name box to specify a new file name for the moved file.
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Moving All the Files in a Folder

Use the following procedure to move all the files in one folder to another.

To move all the files in a folder

1. On a thumbnail index, use the folder box to select the folder that contains the
files you want to move.

2. On the View menu, tap Snapshot Screen or Movie Screen.

•Note that this procedure moves all the snapshot files or all the movie files in

the folder in accordance with the selection you make here.

3. On the Tools menu, tap Batch Move.

•This displays the batch move screen.

4. Tap the Folder box to displays the Select Folder screen.

5. On the Select Folder screen, tap the folder to which you want to move the
files, and then tap OK.

6. Tap OK to move the files.

•Tapping OK closes the batch move screen and moves the files.

Check this box if you want
the files being moved to
replace any files with the
same names in the destina-
tion folder, without displaying
any confirmation message.
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Deleting All the Files in a Folder

Use the following procedure to delete all the files in a folder.

To delete all the files in a folder

1. On a thumbnail index, use the folder box to select the folder that contains the
files you want to delete.

2. On the View menu, tap Snapshot Screen or Movie Screen.

•Note that this procedure deletes all the snapshot files or all the movie files in

the folder in accordance with the selection you make here.

3. On the Tools menu, tap Batch Delete.

•This displays the file delete dialog box.

4. Tap OK to delete the files.

•Tapping OK closes the dialog box and deletes the files.

Check this box if you want
to delete read-only files,
too.
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Refreshing a Thumbnail Index

Any time you select a folder on the Index screen Mobile Picture & Video Player
with Camera automatically displays thumbnails of all the image files (snapshots
and movies) contained in that folder. However, the contents of the Index screen
are not updated automatically when you add or delete image files (using File
Explorer or standard computer operations) in the currently selected folder. Be-
cause of this, you should perform the following thumbnail index refresh operation
whenever you need to update the Index screen so it reflects any changes you
have made to the contents of the folder.

To refresh a thumbnail index
While the thumbnail index you want to refresh is on the screen, tap the Tools
menu and then tap Refresh Thumbnails.

///// Note/////
Performing the above operation generates thumbnails for all the files, both snap-
shots and movies, in the currently selected folder.

Generating Albums

The following procedure creates an album of all the snapshots and movies con-
tained in a particular folder.

To generate an album

1. On a thumbnail screen, use the folder box to select the folder whose images
you want to include in the album.

2. On the Tools menu, tap Make Album.

•See "Albums" on page 49 for full details about albums.
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Attaching a Snapshot or Movie File to E-mail

Use the following procedure to attach a snapshot or movie file to an e-mail mes-
sage.

To attach a snapshot or movie file to e-mail

1. Display the snapshot screen or movie screen of the file you want to attach.

2.  Tap  (Send As Attachment).

                                              Message tab

3. Tap the "Message" tab and input the subject of the messages into the "Sub-
ject" box.

•You can input up to 50 characters for the subject.

4. Input the text of your message.
You can input up to 500 characters for the message text.

•You can also select from among preset message text. See "Selecting a

Preset Message" page 32 for details.

Mail text

Attached image file name

Input the subject of the
message here.
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5. Tap the "To:" tab and input the mail address to which you want to send the
message.
You can use any of the three following methods to input the mail address.

•Direct input

•Input from Contacts

•Inputting a pre-assigned nickname

Direct e-mail input
Type the e-mail address into the box at the bottom of the tab. You can input
up to 200 characters for the address.

Input from Contacts
With this method, you use e-mail data from the Contacts application. Tap the
"down" arrow next to the “Name” box, and then tap the name of the person
whose e-mail address you want to use.

Input the e-mail address here.

Tap here to display a list of
e-mail addresses.

Tap the name of the person
whose e-mail address you
want to use.
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Inputting a pre-assigned nickname
After you assign e-mail addresses to nicknames, you can specify an address
by specifying its nickname. See "To assign a nickname to an e-mail address"
on page 33 for information about assigning nicknames.

6. Tap the "Services" tab and select the service you want to use.
Select the Internet service provider (ISP) you want to use to send the mail. If
you are subscribed to no provider, only "ActiveSync" is available for this set-
ting. See the "Pocket PC User's Guide" for information about ISP and
ActiveSync.

Tap here to display a list of
nicknames.

Tap the nickname whose e-mail
address you want to use.

Tap here and select the
service provider you want to
use.
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7. After making all the necessary settings on the "Message", "To:", and
     "Services" tab, put the queue the message in the Outbox.

On the "Message", "To:", or "Services" tab, tap  (To Outbox).

If you did not specify the addressee of the mail, the message "The To: field
must have at least one addressee." appears. Input the addressee and then
perform this step again.

8. After all the messages have been stored in the Outbox, run the Inbox applica-
tion to send all the queued mail.

Selecting a Preset Message

You can select a preset message when inputting the body of a message in step 4
on page 29.

To select a Preset Message

1. Tap the “Message” tab.

2.  Tap  (Preset Text).

•This displays a list of preset messages from which you can choose.

3. Tap the preset message you want to input and then tap OK.
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To assign a nickname to an e-mail address

1. On the "To:" tab, input the mail address.

2. On the Edit menu, tap Assign name To Address.

•This causes the dialog box shown below to appear.

3. In the "Name" box, input up to 50 characters for the nickname.

4. After inputting the nickname, tap OK to store it.

This stores the nickname and address combination, which you can now use when
sending e-mail messages.

Input the nickname here
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Editing and deleting nicknames

1. On the Edit menu, tap Assign name To Address.

•This causes the dialog box shown below to appear.

2. On the nickname list, tap and hold the nickname you want to edit or delete.

•To edit the nickname, tap "Rename", make the changes you want, and then

store the new nickname.

•To delete the nickname, tap "Delete".

///// Note /////

•A nickname cannot include the colon (:) character.

•You can edit the nickname only. You cannot edit the e-mail address.

Nickname list
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Playing Back Snapshots or Movie Files Attached to E-mail

Use the procedure below to play back snapshots and movie files you receive as
e-mail attachments. Note that an attached file is first imported into main memory
or the storage card before it can be played back.

To playback e-mail attachments

1. On a thumbnail index, the snapshot screen, or the movie screen, use the folder
box to select the folder to which you want to import the attached file.

2. Tap Tools, and then Copy Attachment.
This displays the dialog box shown below.

•The attached file list shows jpg or jpeg format still image files or cmf format

movie files only.

•See the next page for information on how to display e-mail subject, sender,

date and part of the body text contents.

3. Tap the name of the attached file you want to play back.

4. Tap .

///// Note /////
An alart message box appears when the file you are importing has the same
name as an existing file. Change the name and tap OK.

Attached file list

Tap here to select the mail
folder from which you want
to import the attached file.
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To display E-mail Message Information
Use the following procedure to toggle display of e-mail information (subject,
sender, date and part of the body text contents) on and off.

1. On the View menu, tap Display Mail Contents.

• This toggles e-mail message information display on (Display Mail Contents

checked) and off (Display Mail Contents not checked).

2. Tapping anywhere inside the window closes it.

While Display Mail Contents is
checked, a window opens to
shows the subject, sender, date
and part of the body text of an e-
mail message whenever you
select it.
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Using the Snapshot Screen

There are three different snapshot screen views: compressed, uncompressed,
full-screen.

Compressed View .........This view displays the entire image so it appears like a
photograph.

Uncompressed View .....This view displays the image in actual-size. In this view,
you have to scroll the image to view the parts that do not
fit on the screen.

Full-screen View............This view rotates the image and adjusts its size so it fits
within the screen area.

Compressed View                                 Uncompressed View

Full-screen View
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Changing the Snapshot Screen View

Use either of the following procedures to select compressed, uncompressed, or
full-screen as the snapshot screen view.

To change the snapshot screen view

•On the View menu, tap Compressed, Uncompressed, or Full Screen.

•Press the CASSIOPEIA ACTION control to cycle through the three views in

the sequence: compressed - uncompressed - full screen.

About the Snapshot Screen Status Bar

File name
          Total number of index files
File number (in snapshot index)

Changing the Snapshot Screen Image

You can use either of the two procedures described below to scroll through im-
ages on the snapshot screen without returning to the snapshot index. Images
scroll in the sequence they appear on the snapshot index.

To change the snapshot screen image

•On the CASSIOPEIA, rotate the ACTION control up (reverse) or down (for-

ward).

•On the CASSIOPEIA, press the right (or down) cursor button to scroll forward or

the left (or up) cursor button to scroll back.
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Displaying the File Properties of a Snapshot

The file properties dialog provides you with a wealth of information about the file
whose image is currently displayed on the snapshot screen.

To display the file properties of a snapshot

1. On the View menu, tap Properties.

2. To close the file properties dialog box, tap OK.

Changing to a Different Screen

Use the following procedures when you want to change to another screen from
the snapshot screen.

When you want to do this: Do this:

Go to the snapshot index that contains

the displayed snapshot

Go to a slideshow of the folder that

contains the displayed snapshot

Go to the camera screen

Go to the album index screen

Go top the movie index

Tap  

Tap  

Tap 

Tap 

Tap View -

Movie Screen
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Using the Slideshow Screen

The slideshow screen lets you sequentially play back snapshots in the condensed
view.

                                                    Slideshow Screen

Controlling Image Playback

Use the control panel to control the playback of images on the slideshow screen.

... Tap this button to start the slideshow. Images appear in the same se-

quence they are arranged on the snapshot index, for the amount of time

you set using the slideshow settings dialog described on page 41.

... Tap this button to stop the slideshow.

... Tap this button to toggle the direction of the slideshow between forward

and reverse.

 ... Drag the slider left and right to jump to a specific image.

///// Note /////

•Status bar information is identical to that described under "About the Snapshot

Screen Status Bar" on page 38.

•You can also control the direction of the slideshow using the CASSIOPEIA

ACTION control. Rotate down for forward playback, and up for reverse.

Control panel

Status bar
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Making Slideshow Settings

Tapping Slideshow Settings on the View menu displays a dialog box for control-
ling the playback interval and the repeat setting.

Playback Interval . Use this setting to specify how long each image should remain
displayed before changing to the next one. You can set a
value form 1 to 10 seconds, and the initial default setting is 3
seconds.

Auto Repeat ......... Check this box if you want the slideshow to restart from the
first image in the snapshot index after the last image is
reached.

After making the settings you want, tap OK to close the dialog box.

Changing to a Different Screen

Use the following procedures when you want to change to another screen from
the slideshow screen.

When you want to do this: Do this:

Go to the snapshot index that contains

the displayed snapshot

Go to the snapshot screen for the dis-

played snapshot

Go to the camera screen

Go to the album index screen

Go top the movie index

Tap  

Tap  

Tap 

Tap 

Tap View -

Movie Screen
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Using the Movie Screen

The movie screen provides you control over a wide variety of movie playback
features and functions.

Basic Movie File Playback Operations

1. Use the procedure under "Displaying the Movie Screen" on page 23 to display
the movie screen for the movie file you want to play.

                      Name of currently open file                 Play time

•To start playback of the movie file, press  or the ACTION control.

2. To stop movie playback, press  or press the ACTION control.

///// Note /////
Starting up another application or performing any other operation that makes
Mobile Picture & Video Player with Camera non-active while a movie is playing
automatically stops movie playback.

Movie image

Control panel
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Controlling Movie Playback

Use the control panel to control the playback of movie files on the movie screen.

 .........................Tap this button to jump to the beginning (in the case of
forward play) or end (in case of reverse play) of the movie.

 .........................Tap this button to toggle the playback direction of the movie
between forward and reverse. This button does not appear
when you are playing a file for which reverse playback is
disabled.

 .........................Tapping this button changes playback speed in accordance
with the option setting you make under "Movie Screen
Setup" on page 45. This button does not appear when you
are playing a file for which variable speed playback is
disabled.

 .........................Tap this button to start playback at normal speed.

 .........................Tap this button to stop playback.

 .........................Tap this button to cause the playback position to skip back.

 .........................Tap this button to cause the playback position to skip
forward.

 .........................Tap this button to capture a still image of the screen con-
tents. See "Capturing a Still Image of Movie Screen
Contents" on page 44 for details.

///// Note /////
You can also perform a number of control panel operations using the
CASSIOPEIA's buttons. See "Movie Screen Operations using CASSIOPEIA
Buttons" on the next page for details.

Audio volume slider: Slide right to increase audio output volume, or left to
decrease volume.

Playback position slider: Drag the slider left and right to jump to a specific
playback position.
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Movie Screen Operations using CASSIOPEIA Buttons

You can use the CASSIOPEIA's ACTION control and cursor buttons to perform a
variety of different movie screen operations.

During Playback

 Stop playback ...
Press ACTION control

When Stopped

 Start normal speed playback ...
Press ACTION control

 Switch to reverse playback...
Rotate ACTION control up or press the up cursor button

 Switch to forward playback...
Rotate ACTION control down or press the down cursor button

Anytime

 Close the current file and open the next file...
Press the right cursor button

 Close the current file and open the previous file...
Press the left cursor button

Capturing a Still Image of Movie Screen Contents

Use the following procedure to capture the movie screen contents and save the
resulting still image as a JPEG file.

To capture a still image of movie screen contents

1. Play back the movie on the movie screen.

2. Stop playback when it reaches the scene you want to capture.

•You can also use the playback position slider to search for the scene you

want to capture.
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3. Press .

4. In the dialog box that appears, input the name you want to assign to the still
image file.

5. Tap OK.

Movie Screen Setup

Use the following procedure to display the movie screen setup dialog box for
controlling playback speed and auto repeat play, and to make other settings.

To display the movie screen setup dialog

1. On the View menu, tap Movie Playback Settings.

Playback Speed.................. Use this box to specify the playback speed of the
currently open movie file. The options available in this
box depend on the movie file format. The text
"No setting" appears in this box when variable speed
playback is disabled for the currently open movie file.

Auto Repeat ........................ Check this box when you want playback of the
current movie file to automatically restart from the
beginning each time the end of the movie is reached.

Streams .............................. A stream is similar to the track of a tape recording.
These list boxes show the streams contained in the
currently open file. If a file has multiple streams, you
can select one of them here.

2. Tap OK to close the dialog box and apply the settings you made.
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Displaying the File Properties of a Movie

The file properties dialog provides you with a wealth of information about the file
whose image is currently displayed on the movie screen.

To display the file properties of a movie

1. On the View menu, tap Properties.

2. To close the file properties dialog box, tap OK.

Changing to a Different Screen

Use the following procedures when you want to change to another screen from
the movie screen.

When you want to do this: Do this:

Go to the movie index that contains the
movie snapshot

Go to the camera screen

Go to the album index screen

Go top the snapshot index

Tap  

Tap 

Tap 

Tap View -
Shapshot Screen
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Selecting Screen Backgrounds

You can select from among four different backgrounds for the snapshot,
slideshow, and movie screens.

To select a background

1. On the View  menu, tap Backgrounds to display the dialog box shown below.

2. Tap the option button of the background you want to select.

3. When the settings are the way you want, tap OK to apply them and close the
dialog box.



- 48 - Mobile Picture & Video Player with Camera

Adjusting Slideshow and Movie Screen Brightness

You can adjust the screen brightness level of the slideshow and movie screens.
Separate settings can be made for operation under battery power and operation
under AC adapter power.

 To adjust slideshow and movie screen brightness

1. On the View  menu, tap Brightness to display the dialog box shown
below.

2. Drag the sliders left to reduce brightness and right to increase brightness.

•Note that the upper slider controls brightness under battery power, while the

lower slider controls brightness under AC adapter power.

•The brightness settings you make are used during slideshow and movie

playback only.

3. When the settings are the way you want, tap OK to apply them and close the
dialog box.

///// Note /////
The brightness setting you make here does not affect the brightness of the pre-
view screen during recording. See page 16 for information about recording screen
brightness.



- 49 - Mobile Picture & Video Player with Camera

Albums

The album function of the Mobile Picture & Video Player with Camera lets you in-
stantly generate an album with snapshots and movie images pasted inside it.

                Album Index                                              Album Page

The following are some of the main features of the album function.

•You can instantly generate an album for each folder. Album titles (names) are

identical to folder names, so you can group images by theme and manage
folders using the album index screen shown above.

•Once you create an album, you can delete existing images from it or paste new

images into it at any time.

•You can mix snapshots and movie images within the same album.

•There is a choice of four album formats (front cover, back cover, inside page

pattern), two for business and two for personal use. You can also specify one,
three, or six images per album page.

•In the case of 1-image and 3-image pages, you can input text for each image.

•Tapping a thubmnail of an image on an Album Page  instantly displays the

snapshot screen or movie screen of a file. Snapshot screen and movie screen
operations are the same as those described under "Using the Snapshot
Screen" on page 37 and  "Using the Movie Screen" on page 42.

Creating an Album

When creating an album, you first generate an album of all the files contained in a
specific folder. Then you can delete images or paste new images as you want.
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Creating a New Album

Use the following procedure to create a new album of images contained in a
specific folder.

To create a new album

1. On a thumbnail index, use the folder box to select the folder for which you want
to create a new album.

2. On the Tools menu, tap Make Album.

•This displays new album dialog box.

3. Select a format by tapping an option button and then tap Next.
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4. Use the “Number of Images” box to specify how many images you want on
each page.

5. After double-checking to make sure the settings are the way you want, tap
Finish.

•This creates the album and displays its front cover.

///// Note /////
The images of files added to a folder are not automatically added to the folder's
existing album. The images of new files must be pasted into an existing album
using the procedure described on page 61.
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Album Index Screen

The album index shows thumbnails of the covers of all albums currently stored in
the selected folder.

Displaying the Album Index Screen

Use the following procedure to display the album index screen.

To display the album index screen

On the movie screen or snapshot screen, tap the  button to display the album

index screen.

///// Note /////
See "Editing the Album Index" on page 56 for information about various editing
operations that you can perform on the album index screen.

Album cover
thumbnail

A blue frame indi-
cates the currently
selected album. Its
album title is also
highlighted.
Use the cursor keys
or rotate ACTION
control to select
another album.

Album title (folder name)

Number of album pages

Number of images (files)
in the album

Album storage location

 ( : main memory,

: storage card)

Currently selected
folder
Tap here to change to
another folder.
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Displaying the Pages of an Album

You can use album page screen to browse through the pages of an album and
view its contents. Album pages consist of a front cover, inside pages, and back
cover.

                   Front Cover                          Inside Page                              Back Cover

•The title on the front cover is the album title (folder name).

•The following shows the layout of the inside pages of the album.

Album Inside Page

///// Note /////
See "Inserting and Editing Album Page Comment Text" on page 63 for information
about inputting comment text.

Thumbnail
images of album
files You can input comment

text here (page 63).

Tap here to turn the page.
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Displaying the Album Page Screen

You can use any of the following methods to display the album page screen. The
front cover of the album you select appears first.

To display the album page screen

•On the album index, tap the thumbnail image of the album whose page screen

you want to display.

•Select the thumbnail image of the album whose page screen you want to dis-

play (so its album title is highlighted), and then press the CASSIOPEIA's AC-
TION control to open it.

Jumping to a Specific Album Page

After you display the album page screen, you can use the following procedure to
jump to a specific page of the album.

To jump to a specific album page

1. On the album page screen, tap Go To Page on the View menu.

•This displays the dialog box shown below.

2. After specifying the page number you want, tap OK to display it.

///// Note /////
The range of the page numbers you can input in the above procedure starts from
the front cover (page 1) and ends with the final inside page. Note that the back
cover is not counted as a page in the above procedure.

Tap the arrows to change the
displayed page number.
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Displaying the Movie Screen or Snapshot Screen from the Album Page

Screen

You can use either of the following procedures to display the movie screen or
snapshot screen of a particular image displayed on the album page screen.

To display the movie screen or snapshot screen from the album page

screen

•Tap the thumbnail of the image whose movie screen or snapshot screen you

want to display.

•Select the thumbnail of the image whose movie screen or snapshot screen you

want to display (so it has a blue frame around it), and then press the
CASSIOPEIA's ACTION control.

See "Using the Snapshot Screen" on page 37 and "Using the Movie Screen" on
page 32 for information about using the snapshot and movie screens.

///// Note /////

•The buttons on the command bar of a snapshot screen or movie screen dis-

played from the album page screen are different from those that normally ap-
pear there.

When you want to do this: Tap this button:

Return to the album index

Return to the album page that contains
the currently selected image

•The status bar of a snapshot screen displayed from the album page screen

shows the following information.

•See "Editing Album Pages" on page 59 for information about various editing

operations that you can perform on the album page screen.

File name
          Total number of album pages
Page number (in album index)
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Editing the Album Index

You can use the album index to perform the following editing operations.

•Delete the album

•Change the album title (folder name)

•Move the album between main memory and the storage card

Deleting an Album

You can delete an album without deleting its image files, or you can delete an
album along with all the image files it contains. Note that the operation to delete
the album and its image files cannot be undone, so you should confirm that you
no longer need any of the images before you delete them.

To delete an album

1. On the album index screen, tap and hold the album you want to delete,  and
then tap Delete on the shortcut menu that appears.

•This causes the message shown below to appear.

•To close this message dialog box without deleting anything, tap "Cancel".

Otherwise, continue with step 2.

2. Tap a button on the dialog box to perform one of the operations described
below.

When you want to do this: Tap this button:

Delete the album and its image files it
contains

Delete the album but keep its image files

Close the confirmation box without delet-
ing anything

Yes

No

Cancel
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Renaming and Moving an Album

You can use the Rename/Move Album screen to change the name of an album
and the album’s storage folder.

 

Rename/Move Album screen

To change an album title

1. On the album index screen, tap and hold the album whose title you want to
change,  and then tap Rename/Move on the shortcut menu that appears.

•This causes the Rename/Move Album screen to appear.

2. In the Name box, input the new title you want to assign to the album.

•An error message appears if the title you specify is already used. If this

happens, tap the OK button on the error message dialog box and input a
different title.

3. After inputting the title, tap OK.

4. In response to the confirmation message that appears, tap OK to change the
album title.
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To move the storage folder of an album

1. On the album index screen, tap and hold the album whose storage folder you
want to move,  and then tap Rename/Move on the shortcut menu that ap-
pears.

•This causes the Rename/Move Album screen to appear.

2. Tap the Destination Folder box to displays the Select Folder screen.

3. On the Select Folder screen, tap the folder to which you want to move the
album.

4. Tap OK to go back to the  Rename/Move Album screen.

5. Tap OK to move the album.
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Editing Album Pages

You can use the album page screen to add, move, and delete pages, and to add
and edit text comments on the page. This section describes how to perform each
of these operations.

Adding an Album Page

Adding an album page inserts a new blank page in front of the page that is cur-
rently displayed on the album page screen. You can then use the procedure under
"Pasting Snapshot and Movie Images onto an Album Page" on page 61 to paste
snapshot and movie file images into the blank page.

To add an album page

1. On the album page screen, display the page in front of which you want to
insert a blank page.

2. On the Tools menu, tap Add Page.

///// Note /////
Note that the add page command is disabled while the album's front cover is on
the album page screen.

Moving an Album Page

Use the following procedure to move an album page to a different location inside
the same album.

To move an album page

1. On the album page screen, display the page you want to move.

2. On the Tools menu, tap Change Page Order.

•This displays the Change Page Order screen.

•Note that the page count includes the back cover of the album. In the ex-

ample below, the first inside pager is page 1 and the back cover is page 7.

•You can move an album page only to a page (non-cover) location. In the

example below, you can specify a location within the range of 1 through 6 for
the destination of the move.
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3. Use the screen to specify the location to which you want to move the page.

4. After the setting is the way you want, tap OK to apply it.

Deleting an Album Page

When deleting an album page, you get a choice between deleting the page only
without deleting the files of the images on the page, or deleting the page and the
files of the images on the page as well. Note that deleting image files cannot be
undone, so make sure you really do not need image files before you delete them.

To delete an album page

1. On the album page screen, display the page you want to delete.

2. On the Tools menu, tap Delete Page.

•This displays confirmation message asking whether or not you want to delete

the files of the images on the page.

3.  Tap a button on the dialog box to perform one of the operations described
below.

When you want to do this: Tap this button:

Delete the album page and the files of
the images on it

Delete the album page only without
deleting any files

Close the confirmation dialog box with-
out deleting anything

///// Note /////

•Deleting a page causes all the pages after it to shift up and fill the empty space.

•Deleting the last page (the page inside the back cover) causes the back cover
to appear.

Yes

No

Cancel



- 61 - Mobile Picture & Video Player with Camera

Pasting Snapshot and Movie Images onto an Album Page

You can use the following procedure to paste a snapshot or movie image at any
location on the album page.

To paste an image onto an album page

1. On the album page screen, display the page onto which you want to paste an
image.

2. Tap and hold the location on the album page where you want to paste the
image, and then tap Paste on the shortcut menu that appears.

•You can select a location that already contains a snapshot or movie image if

you want. Doing so replaces the original image with the one you select
below. In this case, the file of the original image remains in the album's folder
and is not deleted.

•Tapping Paste on the shortcut menu displays a dialog box for selecting a file

to paste its image.

•This dialog shows pastable file formats (JPEG, CMF) and folders that con-

tain pastable file formats only.

3. Tap the file whose image you want to paste into the album page.

•If the file you tapped is already inside the album's folder, tapping the file

pastes the image and returns to the album page screen.

•If the file you tapped is in a different folder, a confirmation message appears

to ask if you want to copy the file into the album's folder. Tap Yes to copy the
file and paste it onto the album page. Tapping No cancels the paste opera-
tion.
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Deleting an Image from an Album Page

When deleting an image from an album page, you get a choice between deleting
the image only without deleting its file, or deleting the image and its file as well.
Note that deleting an image cannot be undone, so make sure you really do not
need an image before you delete it.

To delete an image from an album page

1. On the album page screen, display the page that contains the image you want
to delete.

2. Tap and hold the image you want to delete,  and then tap Delete on the short-
cut menu that appears.

•This displays a confirmation message asking whether or not you want to

delete the file of the image as well.

3.  Tap a button on the dialog box to perform one of the operations described
below.

When you want to do this: Tap this button:

Delete the image and its file

Delete the image only without deleting its

file

Close the confirmation dialog box with-

out deleting anything

Yes

No

Cancel
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Inserting and Editing Album Page Comment Text

You can use the album page Comments dialog box to add comment text to an
album page and to edit existing comment text.

To insert or edit album page comment text

1. Display the 1-image or 3-image album page whose comment text you want to
input or edit.

•You cannot insert text into a 6-image album page.

2. On the Tools menu, tap Comments to display the album page Comments
dialog box.

•The format of the comment text input dialog that appears here depends on

the type of album page (1-image or 3-image) that you displayed in step 1
above. See "Comment Text Input Dialog Formats" on the next page for
details.

3. Input up to 32 characters in each of the comment boxes. If a comment box
already contains text, you can change it if you want.

•You can use standard CASSIOPEIA text input procedures to input comment

text.

4. After everything is the way you want, tap OK to close the dialog and apply the
text.
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Comment Text Input Dialog Formats

3-image Album Page

Each of the comment boxes corresponds
to an image on the album page.

1-image Album Page

Input the text you want into the
comment box.

Image 1

Image 2

Image 3
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Command Bar Items (Menus and Buttons)

Camera Screen Menus and Buttons

View Menu

Buttons

       Command                                           Description

About Recording

Brightness

About This Screen

When a check mark is next to this menu item, the
"About Recording" dialog box appears whenever you
display a Camera Screen from another screen (Index
Screen, etc.) The "About Recording" dialog box pro-
vides brief explanations of Camera Screen button
operations.

Displays a dialog box for adjusting the brightness of
the screen during record standby.

Displays a dialog box copyright and version informa-
tion about Mobile Picture & Video Player with Camera.
The dialog box also shows a list of CASSIOPEIA key
operations that can be used with this screen.

   Command               Button                                   Description

Playback

Album

Displays the image index screen.

Displays the album index screen.
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Rename/Move
(shortcut menu)

Delete
(shortcut menu)

Batch Move

Batch Delete

Make Album

Refresh Thumbnails

Copy Attachment

Displays a dialog box for changing the name of the
currently selected file or moving the file to a different
storage location.

Deletes the file that is selected on the displayed thumb-
nail index.

Moves all the files in a folder.

Deletes all the files in a folder.

Creates a new album using the files in the currently
displayed thumbnail index.

Generates index thumbnails for all files of the current
index that do not have thumbnails.

Plays an image (snapshot or movie) received as an
e-mail attachment.

Index Screen Menus and Buttons

View Menu

       Command                                           Description

Tools Menu / Shortcut Menu

Snapshot Screen

Movie Screen

Slideshow

About This Screen

Displays snapshot index screen.

Displays movie index screen.

Displays slideshow screen. This command is enabled
only when a snapshot index is displayed.

Displays a dialog box copyright and version information
about Mobile Picture & Video Player with Camera. The
dialog box also shows a list of CASSIOPEIA key opera-
tions that can be used with this screen.

       Command                                           Description
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Playback Menus and Buttons  (Snapshot / Movie / Slide Show Screens)

View Menu

Movie Screen

Snapshot Screen

Compressed
Uncompressed
Full Screen

Properties

Slideshow Settings

Movie Playback
Settings

Backgrounds

Brightness

About This Screen

Displays Movie Index screen.

Displays Snapshot Index screen.

Selects snapshot screen view among “compressed”,
“uncompressed” and “full screen.”

Displays the snapshot or movie properties in accor-
dance with the currently displayed screen (snapshot or
movie).

Displays a dialog box for controlling the slideshow
interval and repeat settings.

Displays a dialog box for controlling the movie variable
playback speed, repeat, and playback stream settings.
<Mo>

Displays a dialog box for changing the background of
currently displayed screen (snapshot, movie, slide
show).

Displays a dialog for adjusting the brightness of the
screen during slideshow and movie playback.

Displays a dialog box copyright and version information
about Mobile Picture & Video Player with Camera. The
dialog box also shows a list of CASSIOPEIA key opera-
tions that can be used with this screen.

       Command                                           Description

   Command               Button                                   Description

Record

Album

Displays the camera screen.

Displays the album index screen.

Buttons
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Copy Attachment Plays an image (snapshot or movie) received as an
e-mail attachment.

Tools Menu

       Command                                           Description

Copy Attachment Menus and Buttons

Restore Default
Column Width

Display Mail Con-
tents

About This Screen

Restores the width of the file list to its initial default.

Checking this item displays part of contents of the file
selected on the file list at the top of the screen.

Displays a dialog box copyright and version information
about Mobile Picture & Video Player with Camera. The
dialog box also shows a list of CASSIOPEIA key opera-
tions that can be used with this screen.

View Menu

   Command               Button                                   Description

Copy and Dis-
play Attachment

Imports and displays the file selected on the
file list.

Buttons

       Command                                           Description

   Command               Button                                   Description

Record

Album

Index

Slideshow

Snapshot

Send As Attach-
ment

Displays the camera screen.

Displays the album index screen.

Displays the index screen.

Displays the slideshow screen.

Displays the snapshot screen.

Displays the “send as attachment” screen.

Buttons
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Send as Attachment Menus and Buttons

Assign Name To
Address

About This Screen

Assigns a nickname to a mail address. This command
is available only while the “Addressee” tab is displayed.

Displays a dialog box copyright and version information
about Mobile Picture & Video Player with Camera. The
dialog box also shows a list of CASSIOPEIA key opera-
tions that can be used with this screen.

   Command               Button                                   Description

Clear

Preset Text

To Outbox

Clears the contents of the subject and body
text boxes.

Displays a dialog box for selecting preset
text. This command is available only while
the “Message” tab is displayed.

Transfers mail to the Outbox.

Buttons

Edit Menu

       Command                                           Description

Album Index Screen Menus and Buttons

Rename/Move

Delete

Displays a dialog box for changing the title of the cur-
rently selected album or moving the album to a different
storage location.

Deletes the album that is selected on the album index.

View Menu

       Command                                           Description

About This Screen Displays a dialog box copyright and version information
about Mobile Picture & Video Player with Camera. The
dialog box also shows a list of CASSIOPEIA key opera-
tions that can be used with this screen.

Shortcut Menu

       Command                                           Description
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   Command                                          Description

Paste
(shortcut menu)

Delete
(shortcut menu)

Comments

Add Page

Change Page
Order

Displays a dialog for selecting an image to paste in the
currently selected position. This command is enabled when
an album page screen is on the display.

•For an album index screen, deletes the currently selected
   album.

•For an album page screen, deletes the currently selected
   image.

Displays a comments dialog for the currently displayed
album page.

Adds a new blank album page before the currently displayed
album page. This command is enabled only when an album
page screen is on the display.

Displays a dialog for moving the currently displayed album
page to a different location. This command is enabled only
when an album page screen is on the display.

Album Page Screen Menus and Buttons

View Menu

Tools Menu / Shortcut Menu

Go To Page

About This Screen

Displays a dialog for jumping to a specific album page.

Displays a dialog box copyright and version information
about Mobile Picture & Video Player with Camera. The
dialog box also shows a list of CASSIOPEIA key opera-
tions that can be used with this screen.

       Command                                           Description

   Command               Button                                   Description

Record

Playback

Displays the camera screen.

Displays the image index screen.

Buttons
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Delete Page

Refresh Thumb-
nails

Displays the currently displayed album page. This
command is enabled only when an album page screen
is on the display.

Generates index thumbnails for all files of the current
index that do not have thumbnails.

       Command                                           Description

   Command               Button                                   Description

Record

Playback

Index

Page

Displays the camera screen.

Displays the image index screen.

Displays the album index screen.

Displays the album page screen.

Buttons


